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RDNET PROTOCOL OVERVIEW 
 
Network description 
 
RDNet system uses a proprietary serial protocol purposely developed by dBTechnologies to create a data 
network which can remotely manage up to 256 compatible devices (ex. dBTechnologies 
professional speakers such as VIO L210, VIO S318, DVA T12, DVA S30N, DVA S1521N, etc.. ). 
The interface is managed by a PC through the dBTechnologies Network software. 
The audio devices are connected to RDNET CONTROL 8 or CONTROL 2 control units, which performs the 
main function of data routing between the PC and the speakers. 
 
RDNET system allows monitoring the status of each device, i.e. the main values to be taken (VU meter, 
temperatures, logistic status, etc.). 
 
The PC cyclically requests the RDNET CONTROL unit the operating state of audio devices, which make up 
the communication network. 
All data are collected by the central unit that performs a sequential scan of all audio devices. 
Digital address allocation is automatic. 
 

 
 
It is possible to check each single audio device and edit its parameters (e.g. output level, 
mute, equalization, delay, etc.) by using the software. 
 
The audio device’s overall configuration can be saved as a file in the PC and later reloaded.  
 
 
Connection topology 
 
The link between the PC and the RDNET CONTROL unit can be made through a USB or Ethernet Port 
(available only  on CONTROL 8). 
USB link can be used when the PC is close to the CONROL unit (just a few meters). 
 

 
 
RDNet CONTROL units can manage up to 2 subnets 
(CONTROL 2) or 8 subnets (CONTROL 8).  
Up to 32 audio devices can be connected to each 
subnet. 
This means that 256 audio devices can be connected 
to Control8  and 64 audio devices can be connected 
to Control 2. 
 
Using Ethernet interface it is possible to connect more 
than one CONTROL 8 unit to the same PC. 
These features virtually extend to infinite the number 
of devices that can be connected to the network. 
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SOFTWARE BASIC OPERATIONS 
 

Main View elements 
 
After installation, default software location is  in “C:\Program Files (x86)\dBTechnologies\dBTechnologies 
Network” folder. 

 
 

 1   Main Menu: allows access to all software functions and settings 
 
 2   General Toolbar: contains some main Menu shortcuts: New/Load/Save synoptic, Zoom In/ Out/Fit, 

Add or delete devices, Lock devices position in synoptic and a link to the “settings” window. 
 
 3   Action/ Synchronize Toolbar:  

− contains access to the Network’s main actions: Scan for network devices, go Online and Offline  
− contains links to Synchronize Equalization and Store Eq. to all devices functions 

 
 4   Modality Toolbar: allows to switch between 2 specific work modalities 
 

 5   Tools Toolbar: contains links to Summary, Properties, Functions List and Group List  Windows 
 
 6   Ethernet connection Toolbar: allows to configure and connect to RDNet CONTROL 8 via ethernet 

connection 
 
 7   Synoptic Area: this is the main working area where all dBTechnologies NETWORK devices will be 
 displayed 
 
 8   Wizard window: allows to quick access to some of the main functions 
 
 9   Status Bar: Shows Information about detected Control 2/8 or USB devices and shows Firmware 

version, registered slave number for each subnetwork and other advanced status information. 
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Scanning device and Online procedure 
 
dBTechnologies Network software can operate in two ways: 

1. Offline :  doesn’t require a connection with a Control 2/8 or any external device. In this mode the user 
can manually design the audio system adding devices to the synoptic area. 

2. Online :  this mode requires almost one Control 2/8 or one USB RDNet device connected to the PC. 
In Online mode each device shown on the synoptic area corresponds to a real RDNet 
device. 

 
The action toolbar permits to quickly toggle between Online and Offline Mode. 

 
Status toggle drop box is locked if any device is connected to the PC. 
 

Note:  
Ethernet devices are not automatically detected by software. For more details about Ethernet   
connection see the specific manual section. 
 

 
Scan Devices button: this button triggers the dBTechnologies Network register procedure that scans 
RDNet network on each available Control and subnet, detects all the connected devices and enumerates. 
If the registration procedure is properly completed, the software automatically switch the mode to “Online”. 
During the registration procedure a log window will appear just to show the registering status and to allow 
procedure abortion. 

 
 
Note: 
Scan Device command is the first step for connecting to an RDNet system 
 

Nonetheless it’s possible to go online just selecting “Online” from the Status drop box. 
This procedure is useful only if Control 8 or Control 2 have already registered endpoint devices, and the user 
doesn’t want to repeat the registration procedure. 
 

 
Note: 
In normal usage it is always advisable to use the “Scan Device” button to go online. 
 

 
 

� 

� 

� 



 

sa                       

6/28  Rev . 

        

                     dBTechnologies 
                         NETWORK dBTechnologies 

 

Load and Save a synoptic 

 
New:  Delete all the synoptic devices and groups and start a new project. 
Save:  It saves the current project as a file. 
Load : It loads a previously saved project file. 

 
Note: 
The project file will be saved as singke file with “.rdw” extension 
 

 
 
 

Add devices in Offline Mode 

 
The “Add ” button, located in the “General” toolbar, will open the” Add Objects” menu on the left of the 
synoptic, showing a list of all dBTechnologies Network supported devices. 
 
This menu allows devices to be added to the synoptic diagram in Offline mode. 
 
To add a speaker,  first select the controller ID and the Line ID ( subnetwork number)  where the device will 
be added, and then double click on the speaker itself.  
 
Devices will be placed near the “next device here” cursor. 
 
Normally, devices detected after a “Scan Devices” operation will be automatically added  in the synoptic  
without using the “Add Object” function. 

 

 
 

� 
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Devices Plugins 
 
When a Device (e.g. VIO L210 or DVA T12)  is connected to RDNet and correctly registered by the RDNet 
software (or added by “Add Object“ function), it is represented on the synoptic window by an object like this: 

 
A descriptive string appears in the left top angle to show the following information: 

1. Controller   number (ex. 1) 
2. sub-network  (line)  number (ex. 5); 
3. device enumeration  address (ex. 2). It is related to the physical connection order on the RDnet 

control's line. First device connected will be enumerated as device 1. 
4. Group   (ex. A).  The “-“ symbol means that no group has been assigned to the device; 
5. Model name   (ex. DVAT12). 

 
Below the descriptive string there is an area that contains: 
Comm   indicator (communication error) that becomes red if a communication error occurs; 
Eq. Sync  indicator:  when green it indicates that the current device’s Group equalization is 

synchronized between software and hardware; Yellow means OUT OF SYNC 
Status   indicator specifies the diffuser’s status; when red it indicates that the device is in FAULT 

condition 
MUTE button; 
SOLO  button; 
Signal Leds:  are located under the central image that graphically represents the device. 
 Leds show the audio signal status for each audio way (ex. LF, MF, and HF for  DVA T12). 
 Leds become green and red according to the respective audio way status (green = signal; 

red = Limiting) 

Signal Vu-meter:  show the input signal level in dBu.  
Compression Vu-meter:   show the compression level (in dB) of the internal limiters. If the device has 

more than one limiter this vu-meter shows the average compression value;. 
Input Clipping Led:      This led indicator becomes red when maximum input signal is reached 

 
 

Clicking on the  button will vertically expand the device and additional parameters and commands are 
shown. 
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MF-HF-LF Panels:  show advanced parameters for each audio way (Midrange, Tweeter and Woofer). 
 
Each panel contains: 

� Vu-meter bar on the left (green): channel amplifier output level in dBfs  (decibel full. scale, 0dBfs = 
maximum power delivered) ;  

� Vu-meter bar on the right (red): channel limiter compression level in dB; 
� amplifier temperature:  indicated in °C 
� Status indicator: green = channel is ok; Red = malfunction is detected; 
� MUTE: single audio way mute 

 
Preset panel:  Select a different audio preset  
 
Hpf preset panel:  Select a different HPF audio preset 

 
Note:  HPF filter is a Linkwitz–Riley high pass filter with a slope of 24dB/oct that is cascaded in 

the input of the audio path of the device. User can change the Crossover frequency. 
 Filters are tuned to perfectly match the Low pass filters present in DVA Rdnet equipped 

subwoofer 
 To obtain best performances is best to select the same xover frequency for both 

Speakers and Subwoofer 
 If Digital HPF filter is used in the top speakers it's important to connect the same audio 

source to sub and tops and avoid to use Xover Out source present in the DVA or VIO 
subwoofers 

 
Thermal Limiter :  Becomes yellow when amplifier module starts reducing Audio volume to prevent 

overheating.  
 
FW Rev:  Show revision of currently loaded Firmware. 
 
Temp :  Indicates PSU temperature in °C. 

 
Standby: enter in standby mode to reduce internal temperature and energy consumption in long 
inactivity conditions. Button is usually green and becomes red in "stand-by" condition.  
Anyway, dBTechnologies NETWORK communication remains active and speaker can be reactivated 

at any time by  pressing the key again. 
 

ATTENTION!! 
If activated, standby button will switch PSU module off and will deactivate audio on all 3 
output channels. 
 

 
Factory Default: Allows to reset all settings made via dBTechnologies NETWORK software and to restore 

factory configuration settings. 
 

 
ATTENTION 
Speaker must be assigned to a group in order to modify the audio equalization. 
 

 
 
Note: 
Please refer to “dBTechnologies NETWORK Device Plug-in” manual for the complete list of 
device to connect dBTechnologies NETWORK software. 
 
 

 
 

 
 
 

� 

� 

� 

� 
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GROUPS AND EQ 
 
Create/Assign/Remove Group  
 
Each device can be assigned to a group in order to change Eq. Delay and Gain. 
To add a device to a group, right-click on the device, select the context menù's “Groups → New” item! 
After assigning a device to a group, its external edge gets the group default color. 
 
 

 
 
To assign a device to a existing group, right-click on the device, select the context menù's “Groups → Assign 
to:” item! 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: 
After assigning a device to a group, its external edge gets the selected group default color. � 
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To remove a device from a existing group, right-click on the device, select the context menù's “Groups → 
Assign to:” item! 

 
After removing a device to a group, its external edge turn off 
 
 
 
 
 
 
 
 
Group usage 
 
In order to edit Group parameters, right-click on the device, select the context menù's “View → 'A(1)'” item: 
 

 
 
 



 

sa                       

11/28  Rev . 

        

                     dBTechnologies 
                         NETWORK dBTechnologies 

 

 
- GAIN:  Signal level attenuation (value: from 0 to –20 dB). 
- DELAY:   Signal delay setting, expressed in the range of 0 ÷ 20 meters. 
- INV. PHASE:   When selected, the signal phase is inverted. 
- SAVE: Opens a “Save File” dialog that permits to save actual filters 
- LOAD:  Loads previously saved filters 
- FLATTEN:   Sets all filters to flat 
- BYPASS EQ. : Temperately bypass the group equalization sending flat volume, delay end filters to the 

devices. 
- PHASE PLOT:  Show/hide phase plot response in the frequency response plot. 
- STORE:  Stores actual filters/Volume/Delay in the internal memory of the grouped devices. For 

detailed information about recalling stored Eq. please refer to the device’s manual. 
- SEND:  Sends actual filters/Volume/Delay to the speaker. In “SoundCheck” modality the button is 

useless since al parameters are sent automatically to devices. 
 
It is possible to set up to 8 selectable filters:  
• DISABLED:  the filter is disabled. 
• PEQ:  Parametric equalizer with editable Gain, Center Frequency Fc and 

Bandwidth; 
• SHELVING_HIGH:   increases or decreases the level of all freq. above Fc by the specified 

amount.. 
• SHELVING_LOW:   increases or decreases the level of all freq. below Fc by the specified 

amount. 
• BUTTERWORTH HPF/LPF (only available in 1st and 2nd  filter slot): Standard High pass or low pass filter 

with selectable slope of 6/12/18/24dB per Octave. 
• LINKWITZ-RILEY HPF/LPF (only available in 1st and 2nd  filter slot): Advanced High pass or low pass 

filter with selectable slope of 6/12/18/24dB per Octave. This filter is useful 
for Cross-over purposes. 

• ELLIPTIC HPF/LPF  (only available in 1st and 2nd  filter slot): ): Advanced High pass or low pass 
filter with selectable slope of 6/12/18/24dB per Octave. 

• BESSEL HPF/LPF  (only available in 1st and 2nd  filter slot): Advanced High pass or low pass 
filter with selectable slope of 6/12/18/24dB per Octave. 

 
Frequency and gain can be adjusted either graphically (with the mouse) by moving the Filter Circle on the 
graph or in an analytical way, by inserting the values in the cells. 
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Note: 
If “SoundCheck” Modality is selected, all parameters (Filters, volume and Delay) are modified in     
real time. In “Concert” modality, depending on the “Live Eq” option in the “Settings” window, 
parameters are not sent in real time and it is necessary to use the “SEND” button manually. 

 
 
The overall Group filter Magnitude response is shown as a red line; single filter curves are shown with green 
lines with lower thickness. 
The overall Group filter Phase response is shown as a yellow line; The Phase plot can be shown or hidden 
by “Phase Plot” button: 
 

 
 
Note: 
The group common data are Gain, Delay and Equalization. If all objects belonging to the same 
group are removed, that group will also be removed and common data will be lost. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

� 

� 
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Groups List Window 

 
The Group list window shows a list with all the active groups: 
 

 
This window permits to: 

• change color of group 
• change name of group 
• open Group Eq. (clicking “View” Button) 
• delete Group Eq. (clicking “Delete” Button) 
• select/deselect the devices belong group (clicking “Select” Button) 
• mute the devices belong group (clicking “MUTE” Button) 
• solo the devices belong group (clicking “SOLO” Button) 

 
 

Devices parameter synchronization 

 
dBTechnologies Network always checks if Group Eq and 2nd EQ data actually configured on the software is 
synchronized with real data on the audio devices. 
If there is a mismatch, the “Eq.Sync” LED on the devices plugin goes yellow, showing that the loudspeaker 
parameters are not synchronized with the software configuration.  
To force synchronization for all connected devices, the “Synchronize” button available in Synchronize toolbar 
can be used. 
 
 

Note: 
The synchronization for all connected devices is automatically forced now at the “Scan Devices”     
process.  
 

 
 
 
 
 
 
 
 

� 
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FUNCTIONS 
 

Create/Assign/Remove Functions 
 

In dBTechnologies Network functions can be applied to a collection of devices and allows the user to: 
1. Change volume and delay of a collection of devices, regardless they belong to an Eq Group. 
2. Add delay algorithm to some devices (ex. Curve algorithm that can be applied to subwoofer) 

 
Unlike Groups, more than one Function can be applied  to the same device. 
dBTechnologies Network automatically calculates the total Gain and delay that must be sent to the devices 
taking into account all Group Eq and other applied functions. 
 
Functions can’t use Eq. Filters, so if users have to change the frequency response of a collection of devices 
they must use the “Group” functionality. 
 
To create a new function, select devices and right-click over one of them, select the context menù's 
“Functions → Master → New” item! 

 
After that function is created, an external ico will be added to all select devices to their right edge: 
 

 
To assign a device to a existing function, right-click on the device, select the context menù's “Functions → 
Masters →  Assign to: → 'Master 0'()1:” item: 
 

 
To remove a device from a existing group, right-click on the device, select the context menù's “Functions → 
Masters →  Remove from: → 'Master 0'()1:” item: 
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Note: 
It is possible create different functions depending on select devices typology: 
 
• Masters (applicable to all subwoofer and box devices ) 
• Curves (applicable only to all subwoofer devices ) 
• Tilts (applicable only to all subwoofer devices ) 
• 2nd Eq  (applicable to all subwoofer and box devices ) 

 

 
 

Note: 
2nd EQ is a new function! Its works like a group equalizer, infact it is an equalizer, the second 
device's equalizer: 
 

 
Unlike group equalizer, you can not modfify the gain, delay, invert phase parameters. Farther there is a list 
of devices belong function on the window's bottom. 

� 

� 
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Other functions are: 
 
• Master  
Function window 's compact view:     Function window 's expanded view: 
 

 
 
• Curve  
Function window 's compact view:      Function window 's expanded view: 

 
 

• Tilt  
Function window 's compact view:      Function window 's expanded view: 
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Functions List Window 

 
The Functions list window shows a list with all the active functions: 
 

 
 
This window permits to: 

• change name of function 
• open specific function window (clicking “View” Button) 
• select/deselect the devices belong group (clicking “Select” Button) 
• delete Group Eq. (clicking “Delete” Button) 

 
 

 



 

sa                       

18/28  Rev . 

        

                     dBTechnologies 
                         NETWORK dBTechnologies 

 

ADVANCED FEATURES 
 

Parameter Protection Modality 

 
dBTechnologies Network  allows to switch between 2 protection level: 

� “SoundCheck” modality: Unprotected Mode;  user can edit all parameters in real time. 
Group Equalization, Volume and delay are changed in Live time; mute, solo and presets are sent to 
audio devices without confirmation. 

� “Concert” modality: Protected Mode, using the “Settings” window user can select one by one which 
parameter will be protected in this modality. Equalization, delay and Gain can be locked or the “Live” 
mode can be disabled, requiring a manual “Send” on every modification. A Confirmation popup can 
be set to request a confirmation for Mute and solo. 

 
Storing parameters in Device 

 
Some dBTechnologies Network compatible devices permit to store in their memory the actual 
Equalizzation/Gain/Delay that users have configured by dBTechnologies Network software. 
The “Store all Eq.” button trigger a store data procedure to all the connected and Store-enabled devices in 
the synoptic. 
For detailed information about recalling stored Eq. please refer to the device’s manual. 
 
Properties Window 

 
The properties window shows all the available properties of the selected devices and allows to change the 
properties values (e.g. Preset, HPF Filter Preset, etc) simultaneously. 
 

 

 
If selected devices are not of the same type (e.g. DVA T12 and DVA S30 in the same selection) only mute is 
displayed. 
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Controllers Window  
 
dBTechnologies Network software supports more than one Control device connected at the same time. 
For example you can connect a Control 2 using USB together with a Control 8 using Ethernet. 
Standalone devices (e.g. AC26N audio processor) can be connected to the PC directly using USB: in this 
case they are seen by the software as “Serial Device” and added in the controller list. 
The controllers window ( Menu → System → Controls list ) displays a list of detected Control units: 
 

 
Controllers window  is useful to: 

� Edit controller name 
� Check IP and MAC address if the control is connected using Ethernet 
� Check the number of slaves connected on each Control sub-network (line) 
� Check firmware version of the Control 

 
Configuration Summary Window 

 
Configuration Summary View ( Menu → System → Summary ) display a list of all connected devices. 
 

 
The “Order by” functionality allow to order devices by Controller, Group and Line: 
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The “Columns Setup” functionality allow to enable/disable specific columns within some useful informations 
regarding devices like: 

 
 
Note: 
The image above show the columns enabled  by default 
 
 
Note: 
Either “Delay” and “Phase” parameters take into account all the Delays variations applied through     
groups and functions into the speakers, and consider preset parameters  (e.g. Delay preset in 
DVA S30). 
 

 

� 

� 
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Communication Log 
 
Communication Log window  (Menu →  Advanced → Communication Log)  show a log of each command 
sent by software to any RDNet device. 
 
It is useful in detecting any failure in the Net.  
Every Command “Cmd” is identified by an ID number and the column “State” indicates the outcome of the 
command. 
 
If an error occurs the “State” field displays “TIMEOUT” or “ERROR” and the user can investigate which 
device generated the error by consulting “Controller”, “Line” and “Slave” fields. 
 

 
 
Control 2 / Control 8 Firmware Upgrade 
 
dBTechnologies Network allows you to update Control 2/8 internal firmware. 
To access this functionality open “Menu → Advanced → Control2/Control8 Firmware Upgrade”: 
 

 
In order to proceed a Control 2/8 unit must be connected through an USB port. 
The default firmware location is  
“C:\Program Files (x86)\dBTechnologies\ dBTechnologies Network\FirmwareUpgrade” 
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Settings 
 

To access this functionality open “Menu → Options → Settings”: 
 

 
 
• Snap to grid: devices placed in synoptic snap to the grid;allow to customize the vertical and   

horizontal grid steps. Default and optimized value is GridX 80 and GridY 80 

• Link Objects when overlap: It’s a magnetic link that graphically joins devices to each other if they are 
overlapped.  

• Synchronize Options: enable/disable the reading of some parameters like Preset and Mute 

at “Scan Devices” program process 

• Wizard Window Options: enable/disable the opening of wizard window at program startup 

• Live Gain Enabled: Real time Gain update in Concert Mode 

• Live Delay Enabled: Real time Delay update in Concert Mode 

• Live Eq. Enabled: Real time Eq filter update Concert Mode 

• Preset Change Confirm: Enable a confirmation request if preset is modified in Concert Mode 

• SOLO and MUTE Confirm: Enable a confirmation request if MUTE/ SOLO commands are activated 
in Concert Mode 

• Eq./Gain/Delay Edit Confirm:  Enable a confirmation request if Eq./Gain/Delay Edit are edited in 
Concert Mode 

• Eq./Gain/Delay Edit Enabled: Enable editing of Eq./Gain/Delay in Concert Mode 

 
 



 

sa                       

23/28  Rev . 

        

                     dBTechnologies 
                         NETWORK dBTechnologies 

 

Wizard Window 
 
To access this functionality open “Menu → File → Wizard”: 
 

 
This window will appear at every program startup. It is a rapid shortcut to some main program's 
functionalities: 

• New Session:  deletes all the synoptic devices and groups displayed and start a new project. The 
“Scan Devices” process is executed automatically if a RDNet control is linked to 
software.  

• Load Session: loads a previously saved project file. 
• Restore Last Session:  loads the latest saved project file! 
 

 
 
Note: 
The dBTechnologies NETWORK save current work session every 5 seconds to perform the 
restore process         whenever necessary 

 
 

� 
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Firmware Upgrade Window 
 
To access this functionality open “Menu → Advance → Devices Firmware Upgrade”: 
 

 
To upgrade the single device follow these tips: 

• choose the specific device model to upgrade by window's “Model” combobox (e.g. T8 )  
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Guidelines will be shown on the window to help the user perform the device upgrade 
 
Note: 
Automatically the latest device's firmware will be selected to perform device upgrade. It will be    
possible select a different device's firmware to perform device upgrade clicking the specific        
window's “LOAD” button 

 
• Click “UPDATE” button to continue the device upgrade process. A new window will be shown: 

 

 
• Click “START UPDATE” button to perform device upgrade: 

 
• Click “OK” button to close device upgrade process: 

 

� 
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ETHERNET CONNECTION 
 
Control 8 can be connected to dBTechnologies Network software through an Ethernet connection. 
The simplest way to configure the connection requires the usage of an Ethernet hub with both PC and 
Control 8 connected. 
 
Configure control 8 

 
To configure Control8 for the Ethernet connection for the first time it’s necessary to connect the control to the 
PC through a USB cable. 
Open dBTechnologies Network software and make sure that RDNet Control8 firmware is updated to the 
latest available release.  
 
To access this functionality open “Menu → Options → Ethernet Control 8 Config”: 
 

 
 
A window will appear showing the current Ethernet IP Address and ports numbers used by the Control 8.  

 
 
Note: 
It’s important that the Ethernet Subnet (the first three numbers of the IP address) matches the 
Ethernet router subnet address. For example if the router’s address is 192.168.1.1, Control8’s IP     
address must be set to 192.168.1.X with X from 2 to 255. 
 
 
Note: 
If your Ethernet router supports DHCP (automatic IP addressing) it is recommended to enable this 
option in the Ethernet configuration window so that an IP address will be automatically assigned. 
 

 

� 

� 
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Connection procedure  
 
Once Control8 Ethernet connection is properly configured, it’s possible to unplug USB and connect PC and 
Control8 to the Ethernet hub. 
 
In dBTechnologies Network software open the Ethernet connection window (“Menu → System → Ethernet 
Connect”): 
 

 
 
 

Use the discovery function to start an automatic search of Ethernet available for Control 8 units. 
 
All the detected Controls will be shown in the list, it is possible to assign to each control an arbitrary name 
and Controller number. 
 
To start a connection with a specific controller in the list first select the controller, and then use the 
“Connect” button. 
The “Connect All” function simply starts a connection with all available controllers. 
The “Disconnect All” function simply starts a disconnection with all available controllers connected. 
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